Important Notices

This material is copyright. It is intended only for MYOB Enterprise Solutions Business Partners and their customers. No part of it may be reproduced in any way without the prior permission of MYOB.

MYOB has carefully prepared this material but excludes (to the extent allowed by legislation) any direct or indirect liability arising from errors or omissions or from its use. Any case studies (including the application of particular accounting standards or legislation) are representative examples only, and will not directly apply to the user’s own circumstances. They are not a substitute for professional advice. Users must check that third party materials, for example from the IRD and the ATO, are current at the time they are used.

Trademark Rights

MYOB is an internationally registered trademark of MYOB Technology Pty Ltd. The use of this trademark and MYOB’s other trademarks is prohibited without prior consent. Other products mentioned may be service marks, trademarks or registered trademarks of their respective owners.
# Table of Contents

MYOB EXO Distribution Advantage ................................................................. 1

On-Demand Purchase Orders ............................................................................ 2
  On-Demand vs. Forecast Purchase Orders ................................................... 2
  End-User Scenarios ....................................................................................... 2
  Viewing Statuses ........................................................................................... 3
  On-Demand Purchase Orders Setup ............................................................. 3
  On-Demand Purchase Orders - General Operation ....................................... 7
  On-Demand Purchase Orders - Other Functions .......................................... 13

Batch Sales Order Line Processing ................................................................. 15
  Task Definition ........................................................................................... 15
  Constraints ................................................................................................... 16
  Setting up Tasks .......................................................................................... 17
  Creating a Task ........................................................................................... 18
  Creating a Sales Order Batch ....................................................................... 28
  The Batch Details Window ........................................................................... 31
  Managing Sales Order Batches ................................................................. 37
  Processing a Sales Order Batch ................................................................. 38
  Batch Sales Order Line Processing Command Line Options ................... 39

Stock Transfer Requests .................................................................................. 40
  Stock Transfer Request Setup ................................................................. 40
  Immediate Stock Transfers ....................................................................... 41
  Making Stock Transfer Requests ............................................................ 42

Sales Order Consolidation ............................................................................... 46
  Prerequisites ................................................................................................ 46
  Workflow summary ...................................................................................... 46
  Limitations .................................................................................................. 47
  Setting up Tasks for Sales Order Consolidation ....................................... 48
  Consolidating Sales Orders ........................................................................ 49
  Sales Order Consolidation Command Line Options .................................. 51

Distribution Advantage - Advanced Setup ....................................................... 52
  Company Profile Settings .......................................................................... 52
  User Profile Settings .................................................................................. 52

Index .............................................................................................................. 53
MYOB EXO Distribution Advantage

The Distribution Advantage module for MYOB EXO Business is a collection of tools that may be used by advanced warehouse and distribution teams. The module consists of:

- On-Demand Purchase Orders
- Batch Sales Order Line Processing
- Stock Transfer Requests
- Sales Order Consolidation

On-Demand Purchase Orders (see page 2) provides an assisted form of creating Purchase Orders directly from Sales Order information. On-Demand checks the individual Sales Order lines, and can either “soft-allocate” current free stock, or raise individual or consolidated Purchase Orders by supplier. This contrasts with the forecast-based Purchase Order function in EXO Business, which reorders stock for items that are below a minimum threshold up to a preset level.

Batch Sales Order Line Processing (see page 15) utilises task definitions to set selection criteria and processing actions. This includes processing of release, pick, supply and invoice quantities. This function differs from the Batch Sales Order processing function in MYOB EXO Business, in that it allows processing at a Sales Order line level rather than by discrete orders.

Stock Transfer Requests (see page 40) can be utilised when enhanced stock transfers are required. This includes when “request then dispatch then receipt”-type processes are required, or when transferred stock is in transit for a period of time such as when being transferred via courier. Stock Transfer Requests can also produce transfer record documentation.

Sales Order Consolidation (see page 46) consolidates orders based on picked (but unsupplied) quantities. Supply and invoicing may then proceed for the consolidated orders. This function may be used (as a separate processing step) in conjunction with other Sales Order functions including Batch Sales Order Line Processing. The consolidation also uses tasks to predefined selection criteria.
On-Demand Purchase Orders

The ‘On-Demand’ function is designed to assist in automating the production of purchase orders to supply specific sales orders or jobs. Industry terms such as ‘procure’ orders or ‘back to back’ orders may be used to generally describe this type of process. The system could also be appropriate in a true indent-ordering scenario.

The default mode of operation effectively groups sales order lines that have not been previously ordered, and raises a purchase order (per supplier) with one consolidated purchase order line per product line. These orders can effectively be generated continuously with very little user intervention.

The scope of this module is limited to assisting the creation of purchase orders and is not intended to provide complete back-to-back functionality or other automated supply chain management. The end user should be aware that any changes forced by customer or supplier changes after purchase orders have been created will not automatically change the status or quantities of those purchase orders. This process must be handled manually outside this program.

A scan process constructs a drillable pro-forma set of data. Products are tagged to their main supplier (as set on the stock item) but may be manually moved to an alternate supplier (and therefore another purchase order). Quantities cannot be amended directly on this form. An ‘Order’ button is used to action each supplier order, allowing the selection of which orders will be placed. Basic purchase order header information is keyed as part of this procedure.

Built-in selection criteria allows a product range to be defined for the scan, and custom selection criteria can be added by way of user-defined purchase groups (including SQL script filtering).

An alternative mode of operation allows stock to be ‘soft allocated’ against the sales orders. Once all stock on hand has been allocated, a second run can be performed to create top-up purchase orders for the remaining sales orders for which stock was not ‘soft allocated’. This feature could be used if the intention is to use a buffer stock holding, or to automatically ‘use up’ previously returned stock in the warehouse.

On-Demand vs. Forecast Purchase Orders

On-Demand purchases contrasts to other methods available in MYOB EXO Business for generating purchase orders. ‘Manual’ purchase orders simply allow a single purchase order to be raised, and the items manually selected. ‘Forecast based’ purchase orders are used to raise a purchase order against a selected supplier (for products normally purchased from that supplier), to ensure stock levels are always above minimum threshold levels.

End-User Scenarios

The following scenarios illustrate possible uses of the Distribution Advantage module.

Fresh goods supply

“Our customers are restaurateurs. They place orders for fresh seafood, fresh salads up to 12.30 for delivery late afternoon/or early following morning. We want to e-mail a single consolidated purchase order to each supplier, our Seafood and our fresh Salad Supplier at 12.45 and at 4.30pm. We ‘poll’ (or scan) for outstanding sales orders manually twice per day.”

Effectively many sales orders to one purchase order.
Portal, Virtual Warehouse, Ship-Direct (charge-through) orders

“We have a large product range but hold no stock. Our customers order products via a web site. We need to organize supply as quickly as possible. Therefore as each Sales order is entered we wish to have a distinct purchase order created and e-mailed (faxed) for each supplier. We have the order-polling feature set to poll automatically every 3 minutes. Each purchase order contains the delivery address of the sales order customer and the goods are shipped direct. The supplier invoices us (with proof of delivery) and we invoice the customer.”

Effectively one sales order to many purchase orders.

Viewing Statuses

To control and indicate the sales orders that have been processed by this module, the system maintains a status code per line within the sales orders. It also updates the corresponding purchase order number of the sales order lines. This information can be exposed on the line periscope of the sales orders form using extra fields. A status code is also updated to the purchase order lines. These status codes may be used for selective reporting if multiple ordering processes are used.

On-Demand Purchase Orders Setup

On-Demand purchase can be customised to provide for basic workflow functionality when integrated into other applications.

*Note: The following steps are normally undertaken during MYOB EXO Business configuration and setup carried out by an EXO Business partner.*

A facility is also provided to form purchasing groups to allow the filtering of sales orders by specific groups debtor accounts – that may or may not be directly be the normal debtor account grouping.

General Setup

On-demand Purchase Orders utilises status codes in the sales and purchase order lines to determine the status of the sales order, and indicates the source of the purchase order. It also provides selection criteria to identify new sales order lines to be processed.
To configure On-Demand Purchase Orders, select **Setup > General Setup** from the On-Demand Purchase Orders window:

![On-Demand - General Setup](image)

**Note:** By default, most of these options are set correctly during installation. Normally these settings only need to be altered if custom functions are to be created.

Supply sales order lines with statuses in the range. These fields specify the range of sales order line statuses to search for. The status is set to zero when a new sales order is entered.

As an example, setting the range to 0-9 may be appropriate if other utilities need to manipulate the sales order before being made available to automatically order.

**If a purchase order is generated**

- **Set the purchase order line status to** Designates the status code updated to the generated purchase orders. This can be used for selective reporting against purchase orders.

- **Set the sales order line status to** Designates the status code updated to the participating sales order lines when a purchase order is generated. The status code must be non-zero and not within the range specified by Supply sales order lines with statuses in the range, so the system flags these lines with this status so that they are omitted from future runs, otherwise they will be continuously reordered. This status can also be used for selective reporting against Sales Orders.

**If include stock**

The following will occur when the Mark from stock process is selected.

- **Supply out of stock in locations** These fields designate a range of locations to scan for stock availability, from which stock can be “allocated” to this order.

- **Set sales order statuses to** Designates the status code that will be updated back into sales order lines if the stock is to be offset against stock-on-hand. The status code must be non-zero and not within the range specified by ‘Supply sales order lines with statuses in the range’, so the system flags these lines with this status so they are omitted from future runs. Please note that this has no effect on the stock file, and is only a nominal association.
**Set the bin code on the sales order to** When the module creates a purchase order the purchase order number is updated to the bin field within the sales order lines. If offsetting against stock an alternate designation can be defined as a constant here. This should be alphanumeric to distinguish it from a purchase order number. It would be advisable for the particular string to indicate that a stock offset was implied.

**Notes**

- During the purchasing process, the purchase order number is stored in `SalesOrd_Lines.PurchOrdNo`. Selective reporting against the sales order can be used to determine which sales order lines are associated with each purchase order. This may provide the basis of an action list for manual follow through after receipting the purchase order.
- The system retains a one-way link from the sales order line to the purchase order (but not the other way around). To determine which sales orders are tagged to a given purchase order, selective reporting against the sales order lines is required.
- Orders supplied from stock are designated by marking the sales order line with a unique sales order status and bin code, as explained in the following section. This allows custom reports to be run, or the sales order to be printed out with this allocation information attached, ready for picking.
- The specific value of the sales order status also designates that the sales order lines are considered offset against stock. This can be used for selective reporting.

**Purchase Groups**

Purchase groups allow for the definition of custom selection criteria when scanning for orders to purchase. This provides the ability to perform the order run in groups, e.g. running “urgent orders” first.

Consider the following when setting up purchase groups:

- This selection could apply to customer or product centric fields.
- Only one Purchase Group can be selected in any given run.
- Lookup items are automatically excluded from purchasing.

**Note:** The configuring of purchase groups requires the entry of database-level SQL statements, and is therefore normally configured by your EXO Business partner. Only the actual SQL selection criteria needs be specified when entering the purchase group SQL statement (that is, do not specify a full SQL WHERE statement).
MYOB EXO Business Distribution Advantage

To configure On-Demand Purchase Orders, select **Setup > Purchase Groups** from the On-Demand Purchase Orders window:

Entering selection logic requires knowledge of SQL. The selection logic is appended to the WHERE clause when priming an on-demand purchase order. Additional selection criteria not otherwise offered by the system may be added.

Tables must be referenced with the following aliases:

- I = STOCK_ITEMS
- A = DR_ACCS
- H = SALESORD_HDR
- L = SALESORD_LINES
On-Demand Purchase Orders - General Operation

The order process is performed in two phases: selecting the items to order, and then raising the actual Purchase Order or allocating from stock.

Selecting Items to Order

The items to order are selected in the main On-Demand Purchase Orders window.

This main screen of On-Demand Purchase Orders determines the items to be ordered, and how the stock items for the Sales Orders will be processed. The following filters are available:

- **Select Groups** filters the range of stock items in this selection process. Select a stock group range with the From and To stock group fields, and if used, select a predefined Purchase group.
- **Select Sales Orders** filters the Sales Order to be processed; select all Sales Orders, orders from a specific customer, or a selected Sales Order.
- Select the **Process Mode** required; whether to create Purchase Orders by supplier or by Sales Order, or mark items as being supplied from stock-on-hand.

The **Process Mode** determines whether stock is ordered by Purchase Order, or allocated from stock. However, the general operation of using On-Demand Purchase Orders is the same for all modes of operation.

To start an On Demand Purchase Order run:

1. Once the filters and process mode have been selected, the details of the orders can be viewed by clicking the **Refresh** button. This will refresh the list of supplier accounts that have stock requirements outstanding on Sales Orders, filtered by the Groups and Sales Order selection criteria.
2. Click the **Forward** button, or double-click on a line to drill down to a product list screen for that supplier. (The **Back** button in the toolbar returns back to the supplier list, if required).
Note: additional options may be displayed on this window, depending on the process mode selected previously.

3. If details of the supplier are required, click the **Show Supplier** button on the toolbar. This will open the standard Creditor Account Details screen from EXO Business, to allow the full creditor details to be viewed.

4. To view the details of the stock item, select the line with the stock item required and click the **Show Stock** button from the toolbar, This will pop up the standard Stock Item Details screen from EXO Business, to allow the full stock item details to be viewed.
5. To see the actual Sales Orders that make up the purchase, click the **Forward** button or double-click on the stock item. This will bring up a list of the Sales Orders that have been grouped for this item. If required, double-click the Sales Order item to drill to display the actual Sales Order.

6. Click the **Back** button to return to the previous window, ready to process.

7. Click the **Back** button again to return to the main On-Demand Purchase Order window, ready to select the supplier to use.

**Purchase Order Per Supplier**

If one Purchase Order per supplier is to be raised, then the **Per Supplier** Purchase Mode should be used. This will consolidate all outstanding Sales Order lines for that supplier, and raise a single Purchase Order against that supplier.

To create a Purchase Order per supplier:

1. Select the Sales Orders to process.
2. Select **Per Supplier** for the Process Mode.
3. Click **Refresh** to update the list.
4. Double-click a supplier to view the order details, ready to raise the Purchase Order. Alternatively select the supplier and press the **Forward** button.
5. To raise a Purchase Order for these items, click the **Process** button. The following window appears:

![Purchase Order Details](image)

6. Enter the relevant details and click **OK**. The Purchase Order is raised.

**Purchase Order per Sales Order**

If separate Purchase Orders are required for each customer Sales Order (to allow a one-to-one supply of Purchase Order to Sales Order), then the **Per Sales Order** Purchase Mode should be used.

As well as raising a separate Purchase Order against a supplier per customer, the delivery address on the Purchase Order is marked with the delivery address of the client for direct shipping. This allows direct supplier to customer delivery.

To create a Purchase Order per Sales Order:

1. Select the Sales Orders to process.
2. Select **Per Sales Order** for the Process Mode.
3. Click **Refresh** to update the list.
4. Double-click the supplier for which Purchase Orders are to be raised against. Alternatively select the supplier and press the **Forward** button. This displays the stock items waiting to be ordered against this supplier:

![Image of On-Demand Purchase Orders window]

5. Select the **Edit details** option if you want to edit each Purchase Order’s header information as the order is generated.

6. As multiple Purchase Orders may be raised during this process, it is possible to control the frequency of printing out and e-mailing each Purchase Order. Select the preferred Print Options and E-mail Options.

7. To begin raising Purchase Orders, click the **Process** button.
8. If the **Edit details** option was selected, the following prompt will appear to allow the Purchase Order header details to be edited, including overriding the Sales Order delivery address that is copied to the individual Purchase Order.

![Purchase Order Details](image)

Enter the relevant details and click **OK**.

9. Purchase Orders are created, and the opportunity to print or e-mail will be provided, depending on the setting of the Print Options and E-mail Options.

10. On completion of all Purchase Orders, a list of all Purchase Order numbers raised is displayed.

### Mark from Stock

Marking a Sales Order as “take from stock” is a simple check to see if existing stock on hand could be used to fulfil the order. The marking from stock does **not** allocate stock, or reserve stock. Therefore it is not sensitive to cumulative allocation of stock in this list.

While this function is simple in operation, it may be useful in sites to ensure any stock on hand is specifically checked first before fresh stock is purchased.

Selecting stock will mark the Sales Order lines with the bin code and Sales Order line status as defined on the General Setup window (see page 3). Set the Bin Code on the Sales Order field. This prevents these being “purchased” using this program during the next purchasing run. A custom report can then be run to view the Sales Order lines that should be checked and supplied from stock on hand.

To check Sales Order lines against stock on hand:

1. Select the Sales Orders to process.
2. Select **Mark from stock** for the Process Mode.
On-Demand Purchase Orders - Other Functions

Moving to a Different Supplier

By default, items are shown again the main supplier of that item, as defined in the main stock screen for that stock item. If it is preferred to purchase that item from another supplier (for example, for out of stock or pricing issues), then it is possible to “push” this item to another supplier.

All items against a supplier can be transferred to a different supplier, or a single item against a supplier can be moved to a different supplier.

To move all items against one supplier to another supplier:

1. From the On-Demand Purchase Orders window, select the line to be moved to an alternate supplier.
2. Click the Transfer Supplier button. Alternatively, right click on a supplier line to open a pop-up menu, and select the Transfer to another supplier option. A Supplier Transfer dialog appears:

   ![Supplier Transfer Dialog](image)

3. Enter the alternate supplier to push the order to. Enter part of the supplier name and press TAB, or enter ? and TAB to search for a supplier name.
4. Click OK. All items against the original supplier will then appear against the new supplier.

   **Tip:** To defer ordering a product, it is possible to move it to another supplier for which an order is not actioned. Dummy supplier accounts such as “Need to find another supplier” or “Purchase under dispute” could be created for this purpose.

To move a single item to another supplier, simply drill down from the original supplier, and right click on the stock item you wish to move to another supplier. The process is then similar to that of moving all items.
Auto Refresh

In some purchasing situations it is desirable to leave the On-Demand screen open continuously, and have the system periodically refresh the list automatically.

To automatically refresh the order list, select **Setup > Auto Refresh** from the On-Demand Purchase Orders window:

Select the **Refresh Every** option, and enter the amount of time between refreshes, in minutes. Click **OK** to close the window.

To disable auto refresh, select the **Disable** option.

*Note:* It is still possible to manually refresh the list in Auto Refresh mode, by clicking the **Refresh** button on the main toolbar.
Batch Sales Order Line Processing

Batch Sales Order Line Processing (BSOLP) provides advantage functionality in the supply and invoice functions when processing sales orders. It can add automation and adds efficiencies to the process. In particular it:

- Provides a view of sales order lines that is not constrained by sales order number boundaries. Lines in a batch may be from multiple sales orders and may also be a subset of lines on those orders.
- Allows pre-definition of each of the Tasks in the process. Standard tasks for the common workflow processes are configured in the database by default. MYOB EXO Business implementers and administrators and may also create customised Tasks to suit the client’s needs. Tasks are tagged with a user profile, thus providing a method of controlling which staff members they are available to.
- Provides enhanced functions for automatically populating quantity fields from a number of different “free stock” calculations. These can be automated within the Task definition.
- Optionally allows grid style manipulation of quantities across the entire batch facilitating user intervention. This can be useful if “best fit” refinement is required following the systems suggested “Free stock” calculated quantities or if only manual entry of figures is required.
- Optionally shows additional breakdown of stock level information for the stock item of the sales order line in focus.

The Standard tasks provided are:

- Release Stock for Backorders (Backorders Only) Print Picking Documents
- Release Stock to unreleased orders (all outstanding orders) Print Picking Documents
- Confirm Picked quantities on Orders currently in picking Print Picking Confirmation
- Supply all Picked Order lines and print Packing Slips
- Invoice all as supplied Print Invoices

Task Definition

If required then the above Standard Tasks may be customised, cloned and changed, or additional custom tasks may be created to establish variants. This may be especially relevant to creating tasks with additional section criteria such as processing preferential customers and products, or where multiple branches operate independently.

Creating tasks is done as a set up process. When creating a batch of sales order lines to process, a pre-defined Task is selected. Task definitions specify the criteria applying to three basic steps in processing a batch:

- Selection criteria to build a list of participating sales order lines.
- An action list to apply to the selected lines that automatically sets quantities to process (optional).
- The transactional process and printing functions required when the Process button is clicked.

Specifying the selection criteria employs a wizard approach. Additional selection criteria can include:

- Select orders from a single location (all or single location)
- Select orders of a particular status (statuses are defined by the system and are not user definable).
- Select orders with a specified combination of outstanding quantity types (e.g. combinations of “has backorders”, “has unreleased”, “has unpicked”, “has unsupplied”, and/or “has uninvoiced”).
- Select orders from a selection of branches (multiple select).
- Select order lines containing specific stock items (multiple select).
MYOB EXO Business Distribution Advantage

- Exclude order lines for stock items that are serial tracked, batch tracked, part of a kit, and/or are a lookup item.
- Select order lines with stock from specific primary suppliers (multiple select).
- Select orders relating to specific sales people (multiple select).
- Select orders for specific customers (multiple select).
- Select orders within a specific range of due dates. A date range measured in days relative to today’s date are specified in the task set up and then resolved to actual start and end dates at run time. Quick select options are also available for ranges Today and Overdue.

Action codes can set (or clear for manual input) quantities for Backorder, Release, Pick, Supply and Invoice. These can be based on one of several calculation methods for “free stock” or a preceding quantity in the workflow (e.g. Invoice as per Supply).

The process functions designate if quantities for Release, Pick Supply, and/or Invoice are to be processed along with printing their corresponding documents.

Constraints

Quantity constraints

The BSOLP function will apply quantity constraints to ensure a subsequent step is not processed with a greater quantity than the step preceding it. This is most obvious by the constraint that invoicing may not occur before supply.

The preceding process for some steps may vary depending on profile settings (e.g. Picked Quantity is only relevant if the profile Sales Order Pick Quantity Enabled is selected).

When processing a negative sales order quantity (credit) the system does quantity comparison by taking absolute value to ensure that “less than” tests are applied.

Within the batch-processing grid, any cell that does not comply with the constraint rules will be highlighted by a red background colour and an error message defining the exception condition will be displayed on the status bar. The user will be inhibited from processing the batch (using the Process button) whilst there are any cells with exceptions.

Bill of Material constraints

BOMs of type Build are always excluded from the BSOLP process. Builds require that all lines (components and output item) be processed as a group (i.e. as an embedded works order). The restriction exists to avoid partially processing a build when the selection criteria may include only some of the component lines within the build.

This restriction does not apply to BOMs of type Kit or Template. A Task may optionally exclude Kits as part of its selection criteria. Template lines are treated as ordinary lines.

Serial and batch numbered items

As these require additional information to be supplied they may also be optionally excluded as part of a Task’s definition.

Provision exists in the grid to key batch numbers on sales order lines appearing within the batch, however there is no provision to split lines where multiple batch codes may be required for a single sales order line. No provision exists to key or alter batch code expiry dates. These dates are determined from the pre-existing batch being consumed.
Serial numbers will pop up the usual serials number selection window for each sales order requiring
serials. This can significantly increase the required user interaction with the system when pressing the
Process button. Excluding serialised items or pre-assigning serial numbers should be considered if the
number of participating serialised orders would otherwise be high.

Setting up Tasks

When Distribution Advantage installs to a database the system creates some default tasks for each of the
possible steps in the workflow. In a simple business environment where additional filtering by customer,
product location etc is not required it is likely the system can be successfully operated with the default
tasks provided.

One of the advantages offered by Batch Sales Order Line Processing is the ability to create additional tasks
to customise the distribution workflow for an organisation and/or individual user or workgroup within that
organisation. Tasks can be created from scratch or copied from an existing task and modified. This section
explains the properties of a Task and how to create and amend tasks.

**Note:** Tasks are also used by the Sales Order Consolidation process (see page 46). The system
creates one default task for this purpose.

To set up Tasks, click the Setup Task button on the main Batch Sales Order Line processing window.
When first selected the Setup Batch Task function displays a search screen of existing tasks.

There are two sets of default tasks provided for use with Batch Sales Order Line Processing:

- The set with filters operating at a sales order line level are marked active and appear by default
  when creating a batch.
- The set with the filters operating at sales order header level is marked as inactive and are hidden by
default when creating a new batch. These can be activated if required.

These tasks can be edited but MYOB recommends that they be left as default and copies be used for
change if customisation is required.
A task performs three basic functions:

- **Select** - This determines lines to be included in a new batch. The criteria are established using a wizard. If necessary the resulting SQL can be edited.
- **Actions** - These are optional and may be used to automatically set quantities after batch creation.
- **Process** - Determines what will be processed and printed when the Process button for the batch is used. The task defaults defined here may be altered for the batch at run time.

In the task setup screen separate tabs exist for each of these functional areas. When creating a new task (see page 18), the Select wizard is launched automatically.

**Creating a Task**

The default Tasks on the Setup Tasks window (see page 17) can be copied and used as the basis of new Tasks, or a new Task can be created from scratch.

**Copying a Task**

To copy a task, select the existing Task you wish to copy and click the **Copy** toolbar button.

The system will create a new Task in the search grid with the words “Copy of” inserted at the start of the original name. This copied task may then be edited.

**Creating a New Task**

To create a new task, click the **New** button on the Setup Tasks window. The following screen is displayed:

![Setup Batch Task](image.png)

**Task Name**  An informative task name should be entered here. This name is displayed when selecting the task to be used when creating a new batch.

**Default Batch Name**  Enter a default name to be used in a created batch. The name will have the batch number appended for each batch created.

**User Profile**  This defaults to All which means the task is available to anyone who may access the Batch Sales Order Line Processing process. By choosing a user profile the task may be limited to only users who are set to that user profile (or one of its decedents).

**Stock to Use**  Select the stock calculation you wish to display and use as default when running a batch of this task. As well as designating the stock figure shown on the stock status bar this also defines the default action when manually using the taskbar buttons **Release**, **Pick**, **Supply** and **Invoice**.

**Sorting Order**  This field may optionally be left blank or if used it controls the order in which the tasks appear in the search window when creating a new batch.
Apply to  This field defaults to a setting of Batch Creation for use with B.S.O.L.P but may be changed to Order Consolidation for use with the Sales Order Consolidation process described in chapter 5.

Active  Clear this checkbox to prevent the task being offered when creating a new batch. The task will always be visible in the task setup function.

Before a task may be saved it must have some valid selection criteria to filter the Sales Order lines that will be added when creating a new batch. The selection criteria is maintained by the use of a wizard.

Run the wizard by clicking the **Wizard** toolbar button or select the Select tab. The Task wizard runs to set the sales order line selection criteria:

1. Select the stock location - all locations (the default) or a single location. Click **Next**.

2. Select the Sales Order Statuses to filter by. Order statuses are used when filtering by sales order header as opposed to sales order lines. Order statuses are defined and maintained by the system and are not user definable.
If filtering is required click Select to display a list of stock items. To select multiple statuses hold down the CTRL key and click multiple lines, then click Select & Close. Click Next to move to the next wizard screen.

3. Select Sales Order Lines. This is usually mutually exclusive with the previous Sales Order Statuses step. Usually one or the other is used.

To use any of these filters select the Select when sales order line option. The other checkboxes then become active provided their corresponding profiles are also active. These filters utilise a logical AND, in that all selected conditions must be true for the sales order line to be included.

- **Has Backorders** - selects when the lines back order quantity is non-zero.
- **Has Unreleased** - selects when the lines unreleased quantity is non-zero.
- **Has Unpicked** - selects when the line has released quantity that is not yet picked.
- **Has Unsupplied** - selects when the lines released quantity (or picked if active) has not yet been supplied.
- **Has Uninvoiced** - selects when there is quantity supplied but not invoiced.

**Note:** The filters in this step do not apply to the Sales Order Consolidation process (see page 46), as consolidation always looks for picked but unsupplied. Settings at this step are ignored during consolidation.

Click Next to proceed to the next step.
4. Select Branches. By default, orders from all branches will be included in the order process.

To restrict the order batch to specific branches click **Select** to display a list of branches. To select multiple branches hold down the CTRL key and click multiple lines, then click **Select & Close**. Click **Next** to move to the next wizard step.

5. Select Stock Codes. By default, all stock codes will be included in the order.

To restrict the order batch to specific stock items click **Select** to display a list of stock items. To select multiple items hold down the CTRL key and click multiple lines, then click **Select & Close**. Click **Next** to move to the next wizard step.

The Select Stock Codes screen has an additional option: **Only with physical stock**. Select this to exclude items that have no On Hand stock. The screen also has an Exclude panel. The options in this panel may be used to exclude items that are serial or batch tracked, are part of a kit, or are lookup items. Serial or batch numbered items require additional information and hence more manual input.

Click **Next** to move to the next wizard step.
6. Select Suppliers. By default, all suppliers are included.

To restrict the order batch by supplier, click Select to display a search window of suppliers. To select multiple suppliers hold down the CTRL key and click multiple lines. The grid may be sorted by clicking column headings. Click Select & Close. The selected list will show the appropriate descriptions of the selected accounts.

Click **Next** to move to the next wizard step.

7. Select Salespeople. By default, all salespeople are selected.

To restrict the list of orders by salespeople, click Select to display a search window of salespeople. To select multiple salespeople hold down the CTRL key and click multiple lines. Click **OK** to close the Select Salespeople dialog.

Click **Next** to move to the next wizard step.
8. Select Customers. By default, all customers are selected.

To restrict the list of orders by customer, click Select to display a search window of customer accounts. To select multiple accounts hold down the CTRL key and click multiple lines. Click Select & Close. The selected list will show the appropriate descriptions of the selected items.

Click Next to move to the next wizard step.

9. You can restrict the order list to a limited range of order due dates (not order placement dates). Dates specified here relative to an unknown “today’s date” and actual dates are resolved when the task is run.
MYOB EXO Business Distribution Advantage

Select one of the following options:

- **Any** - No date selection will occur.
- **Today** - This will resolve to the system date at run time and include due dates for that single day.
- **Overdue** - At run time this will any due dates prior to the system date at run time.
- **Custom range** - This allows a range of dates either side of the run date to be specified. Select the number of days relative to the run date to set a date range. At run time this value will be used to calculate an actual date relative to the run date. A value of zero represents today. Positive numbers represent future dates and negative numbers represent past dates.

Click **Next** to move to the next wizard step.

10. The last stage of the wizard presents a summary of the selection criteria:

![Task Wizard - New](image)

Click **Finish** to save the wizard result in the Task template. The summary information will now also be shown in the Select Summary area of the Details tab.
Entering Selection Criteria Manually

The SQL WHERE clause resulting from the Task Wizard appears on the Select tab. For users with SQL skills, this tab provides the capability to add criteria not encompassed by the questions within the wizard.

To edit the selection criteria manually:

1. Click the Select tab to reveal the current selection criteria:

2. Click the **Edit** button to enable editing for the SQL shown. If customising the SQL then it is recommended that you extend the WHERE clause after the (1=1) line.

3. Click the **Test** button to execute the SQL SELECT statement containing this clause to verify it will run.

**Note:** Table aliases must be used when referencing database fields. These are documented in the yellow information panel at the bottom of the screen.
MYOB EXO Business Distribution Advantage

Actions

Actions specify the batch-level functions to be run once the batch has been created. If quantities are only entered manually then no actions need be specified. It is usual practice to select at least one action to set quantities as a starting point.

To set up actions, click the Actions tab:

![Actions Tab](image)

The available actions on the left are the same actions offered on the drop down menus of the toolbar buttons Release, Pick, Supply and Invoice. Actions therefore provide a way of automatically activating these buttons when creating a batch.

Use the Add, Remove or Remove All buttons to add or remove actions from the right hand list.

**Note:** Actions do not apply to the Sales Order Consolidation process (see page 46).
Process Defaults

This tab is used to set the process settings that will be offered as default when the Process button is clicked within a batch. The defaults may be overridden when processing an individual batch.

**Lock controls at Runtime** Select this option to prevent users overriding these settings at run time.

**Process to** The checkboxes in this panel designate the database activity that will be performed.

**Print documents** The checkboxes in this panel designates which documents will be printed in association with the selected Process to: functions. For some tasks you may not wish to print a document associated with the database activity, e.g. you may wish to update the database with released (authorised) quantities but not print individual picking slips per sales order.

*Note:* The Clarity form BSOLP_PICKSLIP.CLF is used rather than the PACKSLIP.CLF that is used by the Sales Order Supply screen. This allows for the format of picking documents to be different, if required.

**Invoice Date as Sales Order** Check this box to have the invoice date set to the order date of the sales order.

**Force to fully processed** This is usually only set in association with supply and invoicing to force the order to complete as part of the processing function.

**Print labels** This can be set to optionally print labels for each sales order line. The control will only be active if the Clarity document SOLINE.CLF exists.

**Dispatch Method** Tick the dispatch method override if you require to preset a dispatch method. A dispatch method may then be selected from the list.

*Note:* The profile setting Dispatch Information Prompt must be enabled before this setting can be defined and used. Dispatch methods must also be set up in the EXO Business Configuration Assistant at Administration > Couriers > Dispatch methods.

*Note:* Process Defaults do not apply to the Sales Order Consolidation process (see page 46).

**Preprocess SQL**

The Preprocess SQL tab allows users with SQL skills to enter SQL statements to be performed before any other batch processing takes place.
Creating a Sales Order Batch

To create a batch:

1. Select **Batch Sales Order Line Processing** from the Transactions menu. When first opened, the BSOLP function displays a grid of batch headers.

2. Click **New** to create a new batch using a predefined Task. The first screen of the wizard appears:

   ![Batch Task Selection Dialog](image)

   - **Task Name**: Release Stock for Backorders (Backorders Only) Print Packing Documents (Line)

3. Select the required task. A summary is displayed showing the selection criteria applied. The summary also shows a Result count indicating how many rows will be in the batch that is about to be generated.

   ![Batch Summary](image)

   - **Batch Name**: SAPOL
   - **Create New Batch**: Supply all Picked Order lines and print Packing Slips (Line)
   - **Location**: (All)
   - **Sales Order Status**: (All)
   - **Include On Hold**: (All)
   - **Sales Order Lines**: (All)
   - **Has unsupplied**: (All)
   - **Branches**: (All)
   - **Stock Codes**: (All)
   - **Suppliers**: (All)
   - **Sales People**: (All)
   - **Customers**: (All)
   - **Date Range**: Any

   ![Continue and Cancel Buttons](image)
4. Overwrite the batch name if required and click **Continue**. The batch is created. This may take a while if the Result count is large.

**Note:** If the Result count = 0 the Continue button will be inactive and a batch cannot be created with this criteria at this time (i.e. empty batches will not be generated).

5. If actions are specified in the Task they will be automatically executed, after which a message is displayed to indicate they were performed and the batch is displayed:

![Batch Sales Order Line Processing](image)

**Note:** The profile setting *Sales Orders Release Quantity Enabled* determines if the Release button is enabled and the Release column in the grid is available.

The profile setting *Sales Orders Pick Quantity Enabled* determines if the Pick button is enabled and the Pick column in the grid is available.

These profiles both default to disabled.

### Alternative Batch Creation

If necessary, batches can be created directly from a list of Sales Orders, rather than using a Task. This might occur if one or more orders needed be processed outside the usual supply cycle (such as urgent orders).

With this workflow, actions cannot be pre-programmed, as there is no corresponding Task definition. Actions must therefore be run manually from the toolbar or right-click menus or else quantities are entered manually.

When clicking the **Process** button for the batch, the processing defaults are obtained from the same profile set as used in the MYOB EXO Business Quick Supply process.

**Tip:** This process can also be performed for a single sales order with parameter passing from a command line (see section Command line usage) and may therefore be added as a custom button to the EXO Business Sales Order screen.
To manually generate a batch from one or more selected sales orders:

1. Select **New > Batch from Sales Order(s)**. A list of Sales Orders appears:

   ![Select Sales Order Window](image)

   **Order**
   
<table>
<thead>
<tr>
<th>Order_no</th>
<th>Name</th>
<th>Orderdate</th>
<th>Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>10016</td>
<td>MARKET PARTS</td>
<td>4/06/2011</td>
<td></td>
</tr>
<tr>
<td>10017</td>
<td>TERRY'S SPARES</td>
<td>7/05/2011</td>
<td></td>
</tr>
</tbody>
</table>

2. Select a sales order or select multiple sales orders by holding down the CTRL key and clicking multiple lines.

3. Click **Select & Close** to create the batch. This workflow replaces the selection function normally provided by a Task.
The Batch Details Window

The Batch Details window is where a batch of Sales Order lines is manipulated.

When a batch is created (see page 28) or recalled (see page 37), the Batch Sales Order Line Processing screen is displayed.

1. Main Grid

The main grid shows the sales order lines in the current batch, as selected based on the criteria specified in the task that created the batch.

There are a large number of columns available in the main grid (via the Select visible columns function of the grid), and viewing these within the grid may require horizontal scrolling.

Most of the available columns available are read only (denoted by yellow background shading) The editable columns (normally un-shaded) will depend on profile settings but may include order, backorder, release, pick, supply and invoice quantities for each line. Stock batch codes may also be keyed if active.

The cells for Order No, Acc, and Stock Code may be double clicked to drill to the Sales Order, Debtor Account and Stock Item screens respectively. These drill functions are also selectable from the right click menu.

2. Toolbar and Menu bar

The toolbar contains buttons for functions that operate on all rows of the grid. For more details see section Using the Toolbar. Some of these functions compute quantities into the grid. These functions are also available to operate on a single grid line by using the right click menu function on that line (see section Using the sale Order Line Detail Grid).

3. Stock status bar

The stock status bar shows stock information for the currently selected grid line. The On Hand information is for the item/location associated with this line.
4. Stock information panel

Click the button on the toolbar to toggle display of this panel.

The top row shows stock quantity information for the current location.

- **On Hand** - This is the stock level on hand. It changes when a sale stock transaction occurs. For sales orders On Hand stock is consumed when quantity is processed from the Supply column. Supplying also reduces the Committed quantity by the same amount therefore the computed Uncommitted quantity remains unaltered by the supply process.

- **Committed** - This is the total of commitment from unsupplied sales orders plus commitments from other orders such as works orders (components) if used.

- **Uncommitted** - This is computed as On Hand – Committed.

- **Back Order** - This is the sum of back ordered quantities in sales orders. By definition Back Orders are also Unsupplied (Committed).

- **Available** - This is computed as Uncommitted + Back Order. Some users may wish to consider Back Orders as a designation to be supplied from future (incoming) rather than On Hand stock. Use the Available quantity if you wish to exclude Back Ordered quantity from unsupplied when comparing commitment to On Hand stock.

- **Incoming** - This is the sum of uncosted (unreceived) Purchase Orders plus any anticipated manufacture from works orders (output item).

- **Free** - This is computed as Available + Incoming. It indicates the future stock position that would occur if all outstanding orders were supplied (Sales Orders) made (Works Orders) or received (Purchase Orders) assuming no new orders were created.

The bottom row shows summary information for sales orders for this item. Depending on active profiles, it also shows a breakdown of committed quantities progressing along the workflow towards supply.

- **Ordered** - This is the quantity ordered. It includes any correction quantity that represents an adjustment from the original order quantity placed. Corrections could occur as keyed adjustments or can be computer generated to account for oversupply, or for short supply determined by forcing the order to fully processed when there is unsupplied quantity.

- **Supplied** - This is the total quantity supplied (i.e. stock transactions have been written and On Hand has been reduced).

- **Unsupplied** - This is computed as Ordered – Supplied. Note that this can differ from Committed on the top row as it excludes commitment from other order types such as Works Orders (i.e. excludes W/O component commitment).

- **Back Order** - This is the sum of Back Order quantity from Sales Orders. It is the same figure as appears in the top row and is repeated here to portray the correct horizontal arithmetic. This figure will be hidden if it zero and the profile Sales Order Back Order Quantity Enabled is changed to false.

- **Unreleased** - This quantity is usually hidden. It is the portion of unsupplied sales orders that are neither Back Ordered nor Released. This computed quantity can only become non-zero if the profile Sales Order Release Back Order Qty Relationship Enforced is changed to false. By default that profile is set to true meaning that anything not Back Ordered is automatically Released.

- **In Release** - This is the portion of the total Released quantity that has not yet been supplied / supplying (or picked if picking profile enabled).

- **In Pick** - This quantity is usually hidden. It is the portion of the Picked quantities from sales orders that are not yet supplied or in supply. Picking requires the profile Sales Order Pick quantity Enabled to be set true.

- **In Supply** - This is quantity that has been scheduled for supply but has not been processed to stock transactions yet. It is necessary to distinguish this from Supplied (shown in the left hand side of the line) as On Hand stock has not yet been consumed. In supply is therefore also included in Unsupplied (and Committed) until processed.
5. Message bar

The status bar at the bottom of the screen will display a message for any cell that has an invalid entry. Batch Sales Order Line Processing constrains the maximum value of any quantity type to the quantity that precedes it in the processing cycle (e.g. it will not permit release of more than ordered or cannot invoice more than supplied).

**Note:** When the line has a negative order quantity (a return or credit) the system performs the appropriate comparisons by using absolute values.

The system will validate for constraints and any invalid entries will turn the background colour of the invalid cell to red and change the OK column to N (also goes red). The batch cannot be processed whilst any line displays an error condition. When a cell with error condition receives the keyboard focus, the relevant error message will be displayed in the status bar at the bottom of the screen.

In this example the released quantity has been changed from 5 to 6 and now exceeds the ordered quantity. To rectify this situation either reduce the released quantity or increase the ordered quantity (i.e. oversupply).

Changing the Order quantity in this grid preserves the original quantity that was ordered via Sales Orders in EXO Business and records any difference as a Correction quantity. The figure shown here is always the Corrected quantity.

Using the Sales Order Line Details Grid

The grid shows sales order lines. The selection criteria used to create the batch may have included only selected lines for a given sales order; therefore complete orders may not necessarily be included in the batch.

The order number and stock code identifies the line.

The grid may be sorted by clicking one or more column headings. This sequence provides the method to prioritise the allocation of stock when using the toolbar buttons to set quantities.

A number of line functions are available by right-clicking a row in the grid.
<table>
<thead>
<tr>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Stock Levels</strong></td>
<td>This shows a multiple locations grid for the stock item of the row in focus. This can be used to ascertain stock levels in locations other than the location for this line. Other stock level information for the single location of this line is available in the panel at the bottom of the screen.</td>
</tr>
<tr>
<td><strong>Drill to</strong></td>
<td>This provides sub menu items to drill to the Debtor account, Stock item or Sales Order associated with this row. Drilling can also be achieved by double-clicking the Order No, Acc or Stock Code fields in a row.</td>
</tr>
<tr>
<td><strong>Add (Edit) Narrative</strong></td>
<td>This allows either the order line or order header narrative associated with this row to be added or amended. When a line level narrative exists the icon appears on the stock status bar.</td>
</tr>
<tr>
<td><strong>Release Line</strong></td>
<td>These menu items all functions that set (or clear) quantities. They are the line level equivalents of the batch level functions available from the toolbar. Unlike the toolbar buttons these menu functions only alter quantities for the row in focus. The submenus match the drop down menus of those buttons.</td>
</tr>
<tr>
<td><strong>Pick Line</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Supply Line</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Invoice Line</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reset Line</strong></td>
<td></td>
</tr>
</tbody>
</table>

Please see the following Using the toolbar section for a more detailed description of these functions.
Using the Toolbar

The toolbar has the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Close</strong></td>
<td>Closes the BSOLP batch screen. Changes are updated to the database as focus moves off each cell therefore there are no separate Save or Cancel buttons. Use the Close button if you want to suspend your work for later recall and Process.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>Lines are automatically refreshed as they are scrolled. Optionally use this button to refresh the whole grid. Refresh is usually only relevant when displaying some of the additional columns available. The Refresh button re-compares the details of the batch against the live sales orders and updates the display of any differences. The screen can be set to automatically refresh at a specified interval in the Details&gt;Setup Refresh Interval menu item. When the auto-refresh function is active, the icon on the button will have a dot in the centre.</td>
</tr>
<tr>
<td>!<img src="https://zafy.ai/api/progress?mid=10141103" alt="" /></td>
<td>Toggles the display of stock information at the bottom of the screen.</td>
</tr>
<tr>
<td><strong>Release</strong></td>
<td>The actions available from the down arrow to the immediate right of the button are:</td>
</tr>
<tr>
<td></td>
<td>• Release On Hand - Release quantities are set until on hand stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Release Uncommitted - Release quantities are set until uncommitted stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Release Available - Release quantities are set until available stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Release Free Stock - Release quantities are set until free stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Release All - Release quantities are set unconditionally to ordered for the line.</td>
</tr>
<tr>
<td></td>
<td>• Release as per Supply – Sets the release quantity equal to the supply quantity. This is the inverse of the Supply as per Release function of the Supply button.</td>
</tr>
</tbody>
</table>

Release may possibly also make a contra adjustment to the backorder quantity. If the Release quantity is increased sufficiently that:

Released + Backordered > Ordered

then the backordered quantity will be reduced to compensate. This will always occur if the profile Sales Order Release Back Order Qty Relationship Enforced is true (default).

The Release button is disabled if the profile setting **Sales Orders Release Quantity Enabled** is false (default).
<table>
<thead>
<tr>
<th>Pick</th>
<th>The actions available here are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Pick On Hand - Pick quantities are set until on hand stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Pick Uncommitted - Pick quantities are set until uncommitted stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Pick Available - Pick quantities are set until available stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Pick Free Stock - Pick quantities are set until free stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Pick All - Pick quantities are set unconditionally to ordered for the line.</td>
</tr>
<tr>
<td></td>
<td>• Pick as per Release - Sets the pick quantity equal to the release quantity.</td>
</tr>
<tr>
<td></td>
<td>The Pick button is disabled if the profile setting Sales Order Pick Quantity Enabled is false (default).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supply</th>
<th>The actions available here are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Supply On Hand - Pick quantities are set until on hand stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Supply Uncommitted - Pick quantities are set until uncommitted stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Supply Available - Pick quantities are set until available stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Supply Free Stock - Pick quantities are set until free stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Supply All - Supply quantities are set unconditionally to ordered for the line.</td>
</tr>
<tr>
<td></td>
<td>• Supply as per Pick – Sets the supply quantity equal to the picked quantity.</td>
</tr>
<tr>
<td></td>
<td>• Supply as per Release – Sets the supply quantity equal to the release quantity. This is the inverse of the Release as per Supply function of the Release button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Invoice</th>
<th>The functions available here are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Invoice On Hand - Invoice quantities are set until on hand stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Invoice Uncommitted - Invoice quantities are set until uncommitted stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Invoice Available - Invoice quantities are set until available stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Invoice Free Stock - Invoice quantities are set until free stock becomes exhausted.</td>
</tr>
<tr>
<td></td>
<td>• Invoice All - Invoice quantities are set unconditionally to ordered for the line.</td>
</tr>
<tr>
<td></td>
<td>• Invoice as per Supply – Sets the invoice quantity equal to the picked quantity.</td>
</tr>
</tbody>
</table>

| Process      | This button processes the Sales Orders (see page 38).                                           |

The Release, Pick, Supply and Invoice buttons offer actions to allow the quantities to be set (on the entire grid) for a normal workflow. These can set (or clear) quantities. Various calculations are available using different figures from the stock levels information or from a preceding quantity type (e.g. Invoice as supplied). Each button has a choice of actions from their drop-down menus. Pressing the button (without drop down) takes the default action from the drop-down list. The default action will depend on the stock quantity type presently selected at the right of the stock status bar. The tool tip will also indicate the default action. When selected from the toolbar, all actions will display a confirmation dialogue before proceeding.
These actions can also optionally be pre-programmed into the Task definition to occur at the time a batch is created. The default stock quantity type for the stock status bar is always defined by the Task but may be changed at run time.

When calculating from stock levels precedence of the sales order lines can be controlled by using the grid sorting functionality. The grid is processed from top to bottom.

Using the Menu bar

The menu bar has the usual File, Navigate and Help menus. When inside a batch, the Details menu contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the display</td>
</tr>
<tr>
<td>Setup Refresh</td>
<td>Allows the auto refresh capability to be activated or deactivated and sets the refresh interval when active.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets data</td>
</tr>
<tr>
<td>Update Locks Silent</td>
<td>While a Batch Sales Order Line Processing batch is open, the Sales Orders in the batch are locked and cannot be edited by another user. These functions recheck the lock conditions to see if they have been relinquished and the batch can take possession of the lock.</td>
</tr>
</tbody>
</table>

Managing Sales Order Batches

A session may also be suspended for later recall using the Close button. While a sales order line is “owned” by an unprocessed batch it is tagged with the batch number. This prevents it being processed using another EXO Business function or being added to another Batch Sales Order Line Processing batch. This is true for both suspended (closed) batches, as well as one currently open on a workstation.

Loading an Existing Batch

A batch may be suspended without processing by clicking the Close button and then recalled for further amendment or processing. Processed batches that were not deleted after processing may also appear but can only be opened for viewing.

When first opened, the Batch Sales Order Line Processing function displays a grid of batch headers, including previous batches.
Double-click the desired batch to open it and continue editing.

Deleting an Existing Batch

If a batch is no longer required, it may be deleted from the system. This includes batches that were suspended or not deleted after processing. Deleting a suspended batch returns the Sales Order lines to the un-batched pool. Any unprocessed quantities remain in the Sales Order line pending processing as part of another future batch or if processing the Sales Orders as part of another workflow.

To delete an existing batch, select the desired batch and click the button.

Processing a Sales Order Batch

It is normal practice to process a batch once the desired result is obtained within the grid.

A session may also be suspended for later recall using the Close button. Note that there is no Save or Cancel button, as all changes are updated to the Sales Order lines interactively. While a Sales Order line is “owned” by an unprocessed batch it is tagged with the batch number. This prevents it being processed using another EXO Business function or being added to another batch. This holds true for both suspended (Closed) batches, as well as one currently open on a workstation.

Once a batch is processed it may not be altered or processed a second time. If you are separating workflow steps (e.g. separate supply and invoice phases), another Task definition should be used to create a new batch for the next phase.

To process a batch:

1. Click the Process button. The system displays a confirmation message showing the process and print functions that will be performed. These are predefined for each Task but may be changed if required.

2. Click OK to proceed. The system will re-verify the quantities present are OK and process them against the sales orders. Documents will be printed as the system detects each sales order boundary during processing.

3. At the conclusion of processing the you are prompted to delete the batch details.
It is normal practice to delete batches once processed, however they can be retained, possibly for subsequent reporting, and then deleted via the BSOLP batch header search grid later. Sales order lines from a completed batch are always relinquished from the control of that batch so may therefore then be added to a new subsequent batch.

- Click **Yes** to delete the batch. This only deletes the batching information and does not delete the sales order lines.
- Click **No** to retain the batch information. A batch retained after processing is protected from being edited or processed again.

### Batch Sales Order Line Processing Command Line Options

Batch creation can be invoked from outside the Batch Sales Order Line Processing process by the use of command line parameters. This can be done in a number of ways.

- By adding a menu function within another application.
- By adding a custom button to another process within another application.
- By adding menu parameters to an instance of the Batch Sales Order Line Processing menu item within the Distribution Advantage application.

The third case differs from the other two as it may be used within a running instance of the Distribution Advantage application without creating another instance of the application. This effectively move the task selection list to the DA base menu allowing a new batch to be created directly from the menu.

Either of the first two cases may be used with to create a batch from within another application (e.g. from the EXO Business core application or EXO Business Sales Orders).

The command line parameters in these cases are of the form:

```
DA.exe <login> BP /TASK=<task number>
```

Where `<integer>` is the internal task number shown on the task setup header bar. e.g. in the following instance use:

```
/TASK=13
```

The individual sales order method of creating a batch may be used in the form:

```
DA.exe <login> BP /SO=<order number>
```

When using within the menu of Distribution Advantage itself, use the Batch Sales Order Line Processing menu item with parameters of the form:

```
/TASK=<task number>
```
Stock Transfer Requests

Stock Transfer Requests provides enhanced stock movement transactions when:

- Stock transfers require a “request then send” process
- Transferred stock is in transit for a period of time, such as when being transferred via courier, and this needs to be managed

Two types of transfers are available: Immediate Stock Transfers (see page 40) and Stock Transfer Requests (see page 42).

Stock Transfer Request Setup

Stock transfer requests require some setup before use. Profile settings determine overall options, and Stock Transfer Types are used to record the type of requests being used.

Profiles

Some system profiles should be set in order to configure the transfer program accordingly:

- **Stock request transfer transit location** - Specify the intermediate stock location for goods in transit when using Stock Requests for transfers.
- **Stock request transfer percentage warning** - Specify a percentage for the minimum stock to be left in the From location when using Stock Requests for transfers. This does not restrict the transfer quantity but generates an alert when attempting to deplete stock below this level.
- **Stock request transfer quantity warning** - Specify a quantity for the minimum stock to be left in the From location when using Stock Requests for transfers. This does not restrict the transfer quantity but generates an alert when attempting to deplete stock below this level.
- **Suppress Save then Send** - This profile hides the Save then Send option on transfers, which may be useful in some sites to avoid accidentally sending stock requests.

Stock Request Types

Stock Request Types are used to indicate and record the type of request required by the user. They are set up in the EXO Business Configuration Assistant at Administration > Courier > Stock Request Types.
Immediate Stock Transfers

Immediate Stock Transfers are used to perform an immediate, one-step transfer of stock between two locations, and print a matching transfer document. This type of transfer does not use an in-transit location.

To perform a quick transfer:

1. Select **Stock Immediate Transfer** from the Transactions menu. The following screen appears:

2. Click the **New** button to begin a transfer.

3. Specify the staff member performing the transfer in the **By** field.

4. Enter the **From** location and **To** location as appropriate. A warning will be given if the From or To location is the same as the ‘in-transit’ location. While this warning can be ignored, care should be taken with directly transferring to or from the in-transit stock location.

5. Enter a date in the **Required** field, to notify the other party of the date required.

6. Enter any relevant notes in the **Notes** field.

7. In the main grid, enter the required stock code, or enter ? and press TAB to open the stock item search window. Enter the requested quantity, and any comments for the stock line as required.
MYOB EXO Business Distribution Advantage

8. When all the items are entered, press the **Process** button to proceed. The following message is displayed:

![Print dialog box]

9. To print a copy of the Stock Transfer Request from, click **Yes**.

The stock is transferred between the From and To locations immediately.

**Making Stock Transfer Requests**

Stock Transfer Requests are used to perform a multi-step transfer of stock between two locations, including a time in transit. The request follows a request-dispatch-receipt type process. Supporting transfer documents may also be printed.

This function also supports a To-Do list for warehouses to monitor what transfers are awaiting dispatch from their warehouse.

Stock Transfer requests can have the following statuses:

- **New Request** – a new request entered, waiting processing and sending by the From location.
- **Picking** – The request has been saved, and locked ready to pick. However it has not been processed or dispatched yet.
- **In Transit** – a request that has been processed by the From location, and is transferred to the in-transit stock location
- **Complete** – a request that have been received and processed by the To location, and is now complete.

Select **Stock Transfer Request** from the Transactions menu. The following screen appears:
From this screen it is possible to:

- Enter new requests
- Review requests, filtering by status or location or searching by a specific request number
- Process outstanding requests by location

Entering a New Request

1. Click the New button to begin a transfer.
2. Specify the staff member performing the transfer in the **By** field.

3. Enter the **From** location and **To** location as appropriate. A warning will be given if the From or To location is the same as the ‘in-transit’ location. While this warning can be ignored, care should be taken with directly transferring to or from the in-transit stock location.

4. Enter a date in the **Required** field, to notify the other party of the date required.

5. Enter any relevant notes in the **Notes** field.

6. In the main grid, enter the required stock code, or enter ? and press TAB to open the stock item search window. Enter the requested quantity, and any comments for the stock line as required.

7. When all the items are entered, three options are available:
   - **Save** - saves the transfer with the status of “New Request”, but does not close the transfer. This will allocate a request number, and allow transfer documents to be printed, using the [Print button](#) on the toolbar.
   - **Save and Exit** - saves the transfer with the status of “New Request”, and returns to the main Stock Transfer Request window. This sets the request ready to be processed from the From location.
   - **Save then Send** - this is used when the transfer is to be directly entered by the From location and sent immediately. That is, the request is entered and sent immediately by the user in the same location.

### Reviewing Requests

From the main Stock Transfer Request screen, it is possible to review stock transfer requests. The list of transfers may be filtered or searched.

To filter transfer requests by location, select one of the options under **Location**:

- **Select All** to view transfers for all locations
- **Select the From (or to)** option and enter a specific location to restrict the list to only those involving that location. This will list transfers regardless of the request being from or to the specified location.
- **Select the Route (from – to)** option and enter the specific From and To locations that are used in the transfer to list only transfers taking place between these locations.

To filter transfer requests by status, select the relevant check box(es) under **Stock Request Status**.

To search for a specific transfer request, enter a request number in the **Request No.** box and click **Search**.

From the list of transfer requests, you can:

- **View the transfer notes** on a specific entry by clicking a line. (The Notes pane can be turned on and off by selecting the **Show and Hide Notes** option in the File menu or clicking the [button](#)).
- **Refresh the list of items** by selecting **Refresh** from the File menu or clicking the [button](#). The Stock Transfer Request window can be left open to monitor stock requests to be processed for a specific location. In this instance, click the **Refresh** button periodically to ensure the list is current.
- **Process a request** by double-clicking on an entry.
Processing Requests

Stock Transfer Requests follow the Request-Dispatch-Receipt process. Once requests have been entered, the transfer needs to be processed to the next stage.

To process a request, double-click on the selected request.

Once open, the request can be processed to the next stage. Depending on the last state the request was in when saved, the available toolbars buttons will differ to provide the appropriate function:

- If the request was saved without being sent, the **Send** button will be available.
- If the request has been saved and sent, the **Process** button will be available.
- If the request has been sent and processed, the **Receive** button will be available.
Sales Order Consolidation

The Sales Order Consolidation function assists with handling Sales Orders at a line level. It can be used in conjunction with the Batch Sales Order Line Processing (see page 15) function.

While Batch Sales Order Line Processing allows separate treatment of Sales Order lines for processing at each stage of the delivery cycle it has no ability for resulting documents (e.g. packing slips, Invoices etc) to span the boundary of each original order number. In an organisation where individual customers place frequent orders it becomes likely that products for multiple Sales Orders are shipped simultaneously to a customer. There are often gains to be achieved by consolidating lines from individual orders for a customer to single consolidated Sales Order for shipping and subsequent invoicing.

Such a business process requires validation of stock prior to dispatch so that consolidation does not occur for Sales Order lines where stock is physically unavailable. EXO Business provides for signalling confirmation of stock to the database using the optional Picking capability of the software. This allows the operator to enter quantities for stock physically picked (prior to dispatch) as a confirmation that the stock is physically available. Typically at this point the stock has been physically removed from the pick face and placed in a carton, pick tray (or similar) marked for that customer.

To accommodate split quantities (multiple deliveries) per line, the consolidation process relies on the calculation picked, which is supplied when identifying lines as candidates for consolidation. Additional filters may be applied to limit candidate orders by other factors e.g. location, branch, customer, etc. The choices are similar to the Batch Sales Order Line Processing process using the same Task Setup function (see page 17).

With consolidated orders it is important to identify, for each line, the source origin of the line. This is done from a customer perspective and hence uses the Customer Order Number (usually corresponds to the customers own purchase order number). Each consolidated line has a line level customer order number field set to that of the header of the originating order. Non-consolidated orders leave the line level reference blank.

It is anticipated that customisation of Clarity documents for packing slips, invoices etc will be undertaken by the implementer to conditionally print line level references where non-blank (informing the customer of the origination order number). Where no customer reference was supplied (i.e. left blank) the consolidation process will generate one for the consolidated lines (contains internal Sales Order number)

Prerequisites

Picking must be active and used in Sales Orders, i.e. the Company profile setting Enable sales order pick quantity must be set true.

Workflow processes for a picking phase in the dispatch cycle must also be implemented.

Workflow summary

The following describes a typical workflow surrounding the consolidation process and shows how it may be used in conjunction with Batch Sales Order Line Processing (see page 15). Functions performed by Batch Sales Order Line Processing in this example could also be manually processed on an individual order basis.

1. Orders are collected and entered in the normal way.
2. Batch Sales Order Line Processing is used to create a batch of (unconsolidated) order lines in which Release quantities are activated for allocation of stock.
3. Picking slips printed as instruction to the warehouse.
4. Picked quantities are entered and processed (possibly by the warehouse staff) as stock is physically verified.
5. The Sales Order Consolidation process is run to select picked (but unsupplied) quantities and move/split these to consolidated orders grouped by customer code. This requires election of a pre-defined task to activate any filtering that might be required (similar to Batch Sales Order Line Processing).
   - The output is a modified set of Sales Orders.
   - The Sales Order history data is updated for the contributing orders with a new event class to indicate consolidation has occurred (and quantity moved).
   - The released and picked quantities of the contributing lines are reduced by the picked quantity moved and the correction quantity of those lines is updated with the same figure to indicate that the order requirement has been downgraded (shifted to other order lines). Note that if the picked quantity is less than the released quantity then the residual released but not picked quantity remains in the original line.

6. The Batch Sales Order Line Processing process created another batch of picked but unsupplied so as to process the supply and invoice of the picked but unsupplied orders (including the consolidated ones).
   - Packing slips (from supply quantity) and/or Invoices (from invoice quantity) are produced at this point. Paperwork produced will need to be matched with the already picked stock prior to dispatch.
   - Note that this is a fresh batch with its own task (selection criteria) and could potentially include a differing set of lines from that processed in the consolidation run including unconsolidated orders and output from multiple consolidation runs.

**Limitations**

Not all features of EXO Business are supported by the Sales Order Consolidation function. Exceptions are detailed below.

**Workflow timing**

The consolidation function processes quantity which is picked but not supplied.

- The picked quantities must be processed (not just keyed) before consolidation will occur.
- Supply quantities may optionally have been keyed but must not have been processed (i.e. quantity which is already part of a Stock transaction will not be consolidated). Any previously processed supply quantity will remain with the original order

These business rules permit multiple dispatch cycles to have occurred for any given line, but only unsupplied goods will be consolidated. These business rules preclude the consolidation phase being between supply and invoice phases.

**Amalgamation**

Lines for identical products do not amalgamate to a single line per product in the consolidated order. Each line may carry a unique customer reference that must be retained.

When grouping orders the parent/child nature of head office accounts is ignored. Orders for child accounts will amalgamate separately as if they were non-child accounts rather than all child accounts being amalgamated to a single order for head office. This retains reporting integrity for sales analysis purposes.
Stock Batch and Serial numbers

Stock batch codes will travel with the line as it moves to the consolidated order. This is achievable as there can only be one batch code per Sales Order line.

Serial numbers are not processed by the consolidation process. It is not practical to identify which serials of those that may have been pre-assigned should be selected for moving to the consolidated order.

There may also be other serials tagged to the Sales Order which are already supplied (associated with the Stock Transactions that depleted them from stock). As supplied quantity is never moved to the consolidated order the serials for this line which are no longer in stock are not an impediment for consolidation. Only pre-assignment is an impediment.

Credits

Sales orders which have a negative order quantity will eventually result in stock inward and a credit note. The system has been designed to ignore such orders in the consolidation process. It is considered that amalgamation of credit orders would likely defeat business controls associated with the return of goods.

Setting up Tasks for Sales Order Consolidation

One predefined task is supplied for use with the Sales Order Consolidation process. This task has no selection criteria. If additional tasks are required containing selection criteria, they may be set up using the Setup Batch Task window (see page 17) from the Batch Sales Order Line Processing function.

The differences apply when using Tasks with Sales Order Consolidation:

- Set the **Apply to** property to “Order Consolidation”.
- Step 3 of the Task Wizard (Select Sales Order Lines) is not relevant for consolidation and this setting is ignored.
- The Actions tab is not relevant for consolidation and any settings are ignored.
- The Process Defaults tab is not relevant for consolidation and any settings are ignored.
Consolidating Sales Orders

To use the Sales Order Consolidation feature:

1. Open the Sales Order Consolidation window by selecting the Sales Order Consolidation menu item.

2. Initially, only the New button is available. Clicking this button displays a list of tasks which have the Apply to property set to “Order Consolidation”.

---

**Image 1:** Sales Order Consolidation window

**Image 2:** Search Batch Tasks window

---

49
MYOB EXO Business Distribution Advantage

3. Select a task and click Select and Close to create a set of orders.

4. This screen is read only and acts as a visual confirmation step before process. To consolidate the selected orders, click Process.

5. After processing a summary screen is displayed. This may be printed if required.

If you have multiple tasks defined you may wish to click New and select another task with different selection criteria; otherwise close the screen.
Sales Order Consolidation Command Line Options

Sales Order Consolidation can be invoked by the use of command line parameters. This can be done in a number of ways:

- By adding a menu function within another application.
- By adding a custom button to another process within another application.
- By adding menu parameters to an instance of the Sales Order Consolidation menu item within the Distribution Advantage application.

The third case differs from the other two as it may be used within a running instance of the Distribution Advantage application without creating another instance of the application. This effectively moves the task selection list to the DA base menu allowing a new batch to be created directly from the menu.

Either of the first two cases may be used with to create a batch from within another application (e.g. from the EXO Business core application or EXO Business Sales Orders).

The command line parameters in these cases are of the form:

```
DA.exe <login> SC /TASK=<task number>
```

Where `<integer>` is the internal task number shown on the task setup header bar. e.g. in the following instance use:

```
/TASK=18
```

When using within the menu of DA itself use the Sales Order Consolidation menu item with parameters of the form:

```
/TASK=<task number>
```
Distribution Advantage - Advanced Setup

The following profile settings allow for advanced configuration of the Distribution Advantage module.

Company Profile Settings

**Enforce sales order quantity constraints**  Constrains Sales Order quantities to a maximum of their preceding type, e.g. restricting invoice quantity to supply quantity.

**Enforce constraint of sales order quantity ad release quantity + backorder quantity**  Select to constrain the unsupplied quantity to be either Released or Back Ordered (Order Qty = Release Qty + Back Order Qty)

**Enable sales order back order quantity**  Select to use the back order quantity feature on Sales Orders and permit manual control of the back order quantity from Sales Order entry. When this profile is inactive, a quantity can still appear in the calculated field Unsupplied. Activating this profile allows differentiation of the unsupplied quantity into Back Ordered and non-Back Ordered.

**Enable sales order pick quantity**  Select to use the pick quantity feature on Sales Orders and permit manual control of the picking quantity from Sales Order entry. This is an additional phase preceding supply and does not alter stock levels. If picking is enabled then pre-assignment of serial numbers also constitutes picking and updates picked quantities.

**Enable sales orders release quantity**  Select to use the release quantity feature on Sales Orders to manually control supplied quantity from Sales Order entry. For example, for stock rationing

**Stock request transfer quantity warning**  Specify a quantity for the minimum stock to be left in the From location when using Stock Requests for transfers. This does not restrict the transfer quantity but generates an alert when attempting to deplete stock below this level.

**Stock request transfer percentage warning**  Specify a percentage for the minimum stock to be left in the From location when using Stock Requests for transfers. This does not restrict the transfer quantity but generates an alert when attempting to deplete stock below this level.

**Intermediate stock location for goods in transit**  Specify the intermediate stock location for goods in transit when using Stock Requests for transfers.

User Profile Settings

**Constrain stock request transfer processing**  Constrain stock request transfer processing to only process stock transactions (process send or receive) from/to users default location or the in-transit location.

**Stock request transfer suppress ‘save then send’**  Hide the Save then Send button on the Stock Transfer Request (see page 42) window.
Index

A
Auto Refresh ..................................................14

B
Batch Sales Order Line Processing ...............15
   command line options ...........................................39
   operation ................................................................38

D
Distribution Advantage ....................................1
   profile settings ..................................................52

I
Immediate Stock Transfers .............................41

O
On-Demand Purchase Orders ............................2
   changing suppliers .............................................13
   operation ................................................................7
   setting up ..........................................................3

P
Purchase Mode
   Mark from Stock .............................................12
   Per Sales Order ................................................10
   Per Supplier ......................................................9

S
Sales Order Batches
   creating ..............................................................28
   deleting .............................................................37
   details ................................................................31
   loading .............................................................37
   managing ..........................................................37
   processing .........................................................38

Sales Order Consolidation ................................46
   command line options ......................................51
   operation ..........................................................49
   setting up tasks .................................................48

Stock Transfer Requests ..................................40
   making .............................................................42
   processing ........................................................45
   reviewing ........................................................44
   setting up .........................................................40

Supplier Transfer .............................................13

T
Tasks (DA)
   creating ............................................................18
   setting up ........................................................17